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Product features
Front View 

NOTE: When you turn on the frame or tap the Quick Touch Borders, the screen icons appear and lights 
indicate where to touch the Borders. 
To use the Quick Touch Borders, see page 3.

1 OLED screen

2 Quick Touch Border (side, tap only)

3 Quick Touch Border (bottom, tap and slide)

4 LED lights

5 Memory card slot - SD, SDHC, MMC, MS, xD
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Back/Side View

1 USB connector (to computer) 5 DC-In (12V) 

2 USB connector (to camera/USB device) 6 Volume

3 Audio In (external audio, i.e. MP3 player) 7 Power button 

4 Audio Out (headphones or speakers) 8 Speakers
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1 Getting started

Welcome to your KODAK OLED Wireless Frame. Viewing your pictures with 
spectacular clarity and brightness couldn’t be simpler! 

Setting up your frame
Attaching the power cable

CAUTION:
Do not use this power cable with other devices, including digital 
cameras.

1

2

Your power cable may look different from 
the one pictured. Use the plug that 
accommodates your type of power outlet.
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Getting started
Turning your frame on and off

Power button - press and hold (for about 2 seconds), then release

With the power cable still plugged in, 
your frame retains information (like 
the time) if you turn it off.
www.kodak.com/go/support  2



Getting started
Using your frame’s Quick Touch Borders
IMPORTANT: The display screen is not touch-sensitive. Do not touch it. Lights appear on 

the borders (upper right and bottom) to show you where to touch.

CAUTION:
Only use your finger on the borders; borders do not react to sharp 
or metal objects—they may damage the border or screen.

Done
CloseTap the light 

closest to an icon* 
to select it.

Touch tips

Home
Play slide show

Quick Touch 

Tap and slide on the Quick 
Touch Borders only.

Tap lights 
below icons*
Slide on 
bottom border 
only

Slide to highlight 
menus, pictures, 
videos, options.** 
Tap OK to select 
them.

Slide to scroll:
Scroll through images—Like turning the pages of a book, slide left ← to go forward, slide right → to go back. For 
faster scrolling through larger numbers of pictures, touch and hold (3 seconds), then slide to the end of the border.

Scroll through menus—Slide right → to scroll down, slide left ← to scroll up.

Borders

Tap lights next to 
icons* 

Don’t hover, 
borders can be 
sensitive.

(No sliding here)

Tap a border to 
display the icons. 
Tap Close to 
dismiss them.

OK

* Icons change color when they are selected.

** Tap below arrows at the ends of the scroll bar to move the highlight one picture, menu, or item at a time.

** Tap below arrows
3 www.kodak.com/go/support



Getting started
Setting your language
The language screen appears the first time you turn on your frame. 

■ Slide (or tap below slider arrows) on the lights at 
the bottom border to highlight your language, then 
tap Save.

To change the language at a later time:

■ Tap  (Home) →  (Settings) → Language. 

The language screen appears.

Highlight your language, then tap Save.

To use the Quick Touch Borders, see page 3.

Connecting to your wireless network
After you set your language, your frame automatically scans for available wireless 
networks.

To continue with this initial network setup, see Connecting to your wireless 
network—first time, page 5.

If you want to connect to your wireless home network later and start enjoying your 
pictures now, insert a memory card or connect a camera or other USB device with 
pictures (see page 26). To bypass the initial network setup and connect later, see 
Connecting to your wireless network later, page 7.

Slider arrows
Save
www.kodak.com/go/support  4



2 Setting up for wireless 
operation

To allow your frame to access the contents of your computer wirelessly, connect your 
frame to your wireless home network.

NOTE: If you are not sure you have a wireless network, ask the person who set up your computer.

If you have problems with your wireless setup or connection, see 
Troubleshooting starting on page 63. Or open KODAK EASYSHARE Digital Display 
Software on your computer (see page 8) and click Tools → Wireless Troubleshooter. 
Follow the automated troubleshooting wizard.

Connecting to your wireless network—first time
The first time you turn on your frame, the wireless setup screens automatically appear 
after you set your language and tap Save (see page 4).

The frame scans for available networks and then your available networks are listed.

If your wireless network is not listed, follow the directions on page 8, then return to this 
page and resume this connection procedure.

1 Slide or tap below the arrows to highlight your home network, then tap OK.

NOTE:
If the scan finds multiple 
networks, your home 
network is usually listed first 
and highlighted. 

Networks are listed by % of 
signal strength.
5 www.kodak.com/go/support



Setting up for wireless operation
The Connecting screen (or the wireless network security screen, if enabled) appears.

Or, tap Exit to go to the Home screen without connecting. (See page 27.)

2 If you do not have wireless network security enabled, go to step 3. 
(However, we recommend that you enable your network security to prevent others 
from accessing your wireless home network.)

If you have wireless network security enabled, the on-screen keyboard 
appears. Enter your security key:

a Highlight a character, then tap  (Select) to enter it in the text box.

(To highlight a character, slide along the bottom of the touch border or tap 
below the slider arrows.)

b Repeat for each character of your security key, then tap Done.

On-screen keyboard:

Congratulations! You have successfully connected your frame to your network! 

Select

Text box

Slider
Slider arrows

Backspace key        erases text

Bottom border - keep sliding 
(or tapping slider arrows) 
left/right to go to the previous 
or next row.

Touch tips

Right border - tap only
www.kodak.com/go/support  6



Setting up for wireless operation
NOTE: The screen identifies your security as either WEP or WPA.

A WEP security key can be either: 

5 or 13 characters (0-9, A-Z, some special characters, case sensitive)

10 or 26 characters (0-9, A-F, not case sensitive).

A WPA key is 8-63 characters, case sensitive.

The person who set up your network can provide you with this information.

IMPORTANT: Do not select Scan now (to verify connections, page 10) until you have 
installed the software. 

3 If you haven’t done so already, install the KODAK EASYSHARE Digital Display 
Software on your WINDOWS OS computer (see page 8) so you can set up and 
customize your frame right from your computer wirelessly. For MAC OS users, see 
page 12.

Connecting to your wireless network later
If you chose not to connect to your network when you first turned on your frame, you 
can do it at any time. Here’s how.

1 Tap Home → Settings .
2 Slide to highlight Network, then tap Select.

3 Highlight Scan for wireless networks, then tap OK. 

4 Follow the screen prompts and continue with step 1 on page 5.
7 www.kodak.com/go/support



Setting up for wireless operation
If your wireless network is not found
If your wireless network is not found (from page 5), follow these suggestions: 

1 Slide to highlight My network not shown, then select OK.

2 Check that your router is on and your frame is close to the router, then select Scan 
again.

If your wireless network is still not found, your network does not broadcast SSIDs. You 
then need to enter the network SSID (sometimes called the network name) manually:

1 Select Enter SSID, then tap OK.

The on-screen keyboard appears.

2 Enter the SSID in the text box (see page 6). Tap Done when finished.

The person who set up your network can help you with this information. Or, tap Back 
then tap Help me connect for more information.

3 When your network is found and listed, return to step 1 on page 5.

Installing the software: WINDOWS OS only
IMPORTANT: For MAC OS users, do not install the software on your computer. See 

page 12 to start setting up access to Web content.

The CD that was packaged with your frame contains two applications that work well 
independently, but also work together for the best experience with your frame:

■ KODAK EASYSHARE Digital Display Software —manage your frame right 
from your computer, copy between your frame and computer (page 44), and set up 
your frame for access to KODAK Gallery and Web content (page 11).

■ KODAK EASYSHARE Software —organize, edit, and share your pictures.

IMPORTANT: We recommend that you install both. If you already have EASYSHARE 
Software on your computer, upgrade to this special version for additional 
features.
www.kodak.com/go/support  8



Setting up for wireless operation
1 Insert the CD into your computer.

2 Follow the on-screen instructions to install the 
software.

■ Click Typical to install EASYSHARE Digital 
Display Software and to update a previous 
version of EASYSHARE Software.

■ If you do not have a previous version of 
EASYSHARE Software on your computer, you 
can click Custom and choose both applications 
for a new installation.

The software icons appear on your desktop when the 
installation is complete.

3 Double-click  to open EASYSHARE Digital 
Display Software if it doesn’t open automatically.

The first time you open Digital Display Software, the 
wireless setup wizard automatically leads you through 
these next setup steps.

Follow the setup wizard screens to start your wireless setup:

1 Select Next on the Welcome screen. Then select Yes, when asked if you are setting 
up for a wireless frame.

2 Select Enable media sharing to allow your frame to access pictures on your 
computer. Then click Next.

3 To set up your Web media content now, select Yes, set up Web media now. Then 
click Next and follow the directions in Chapter 3, Setting up Web content.

To complete your wireless setup, select No thanks, then Finish. To set up your Web 
media content later, see Chapter 3, Setting up Web content.

When prompted, take a few minutes to electronically register your frame and software 
for exclusive tips and offers. To register later, visit www.kodak.com/go/register.

CD packaged 
with your frame.
9 www.kodak.com/go/support



Setting up for wireless operation
Verifying computer/device connections
After installing the software (page 8), return to your frame, then:

1 Tap OK.

The network connection setup screen appears.

2 Tap Scan now to verify your computer connection.

NOTE: Select Scan later if you want to finish your wireless setup at a later time. Your frame cannot access 
your wireless network until you have verified. To do so later, tap Home → Settings → Network 
→ Verify computer connection.

The Scanning screen appears as the frame scans your network and then lists available 
computers and other picture sources that your frame can access wirelessly.

3 If your computer is listed, your wireless connection is successful. Tap Done to close 
the window.

If your computer is not listed, tap Scan again or tap Help for options.

You have completed the frame setup. Your frame can now access the content on your 
host computer, wirelessly. Your computer appears as a picture source icon  on 
your frame’s Home screen (see page 28). Touch  (Home) to start viewing your 
pictures.

NOTE: If you have more than one frame on your wireless network, give them unique names using the 
on-screen keyboard so you can tell them apart. Go to Home → Settings → Device configuration 

menu. See page 57.

Connected computers 
and devices
www.kodak.com/go/support  10



3 Setting up Web content

Opening the Device Settings Web page
On your computer, open your frame’s Device Settings Web page in your browser. 
You’ll use it to set up access to the KODAK Gallery and RSS (Really Simple 
Syndication) feeds from services like FLICKR® and FRAMECHANNEL.

IMPORTANT: WINDOWS OS users—use KODAK EASYSHARE Digital Display Software to 
open the Device Settings Web page.
MAC OS users—enter the frame’s IP address in your browser to open the 
Device Settings page. See page 12.

WINDOWS OS users
WINDOWS OS users, here’s how to open your frame’s Device Settings Web page:

1 Make sure the frame and computer are connected to your wireless network 
(page 5) and your computer is connected to the Internet.

2 On your computer, click  on your desktop to 
open EASYSHARE Digital Display Software.

3 Right-click the frame in the Drag and Drop Zone, 
then select Device Settings.

Your frame’s Device Settings Web page opens in your 
browser (see page 13).

KODAK EASYSHARE Digital 
Display Software
11 www.kodak.com/go/support



Setting up Web content
MAC OS users
MAC OS users, here’s how to open your frame’s Device Settings Web page:

1 Make sure the frame is connected to your wireless network (page 5) and your 
computer is connected to the Internet.

2 Get your frame’s IP address:

a On the frame, tap Home → Settings → Network, then tap Select.

b Make a note of the IP address (format: XXX.XXX.X.XXX) from the frame’s 
Network Settings screen.

3 Open a browser (for example, INTERNET EXPLORER, MOZILLA FIREFOX, SAFARI, 
etc.) on your computer. 

4 Enter the IP address in the browser’s address window, then press Enter.

The KODAK Displays and Devices Configuration page (Display Settings Web page) 
opens in your browser (see page 13).

Enter the IP address here
www.kodak.com/go/support  12



Setting up Web content
Your frame’s Device Settings Web page

1 From the drop-down menu, select your frame.

2 Click the following Web Media tabs for on-screen setup instructions.

■ KODAK Gallery—connect to your existing Gallery account or set up a new one 
to receive pictures from Gallery friends and family. See page 14.

■ FLICKR service—sign in to your existing FLICKR account or set up a new one 
(see page 15) so you can receive and view FLICKR photos on your frame.

■ FRAMECHANNEL service—connect to your existing FRAMECHANNEL account 
or set up a new one (see page 16) so you can customize content such as 
news, weather, traffic, sports scores, finance, and much more. Add to your list 
of RSS photo feeds from FRAMECHANNEL (see page 19) and receive photos 
from your favorite photo-sharing sites.

■ Photo RSS—add to your list of RSS photo feeds from FLICKR and other 
favorite photo-sharing sites (see page 17).

■ Create shortcuts—put shortcuts of your favorite photo feeds right on the 
frame’s Home screen (see page 23). 

■ Settings—customize your frame settings right from your computer. You can 
also change Settings from your frame (see page 55).

NOTE: Use the preview, edit, and delete features to manage your feeds (see page 24).

1

2
Web Media 
tabs
13 www.kodak.com/go/support



Setting up Web content
Connecting to your Gallery account
Perform this one-time setup on your frame to connect it to your existing KODAK 
Gallery account.

1 Follow the steps on page 11 to access the Device Settings Web page.

2 Click the KODAK Gallery tab.

The Gallery page appears.

3 If you don’t have a Gallery account, click Set one up now. Follow the on-screen 
instructions, or visit www.kodakgallery.com. Then continue with step 4.

4 Select your country/region from the drop-down menu.

5 Enter the email address that is associated with your Gallery account, then enter 
your Gallery password.

6 Select a Picture Mail automatic notification setting. For more about Picture Mail, 
see Automatically receiving My Friends Albums, page 40.

7 Click Save.

Congratulations, you have completed your Gallery setup! KODAK Gallery is added to 
the Web media list on your frame’s Home screen (see page 27). To create a KODAK 
Gallery shortcut on the Home screen, see page 23.

5
6

7

4

3

2
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Setting up Web content
Connecting to your FLICKR account
To view your FLICKR photos on your digital frame, you need a FLICKR account.

1 Follow the steps on page 11 to access the Device Settings Web page.

2 Click the FLICKR tab.

The FLICKR page appears.

3 If you don’t have a FLICKR account, click Set one up. Follow the on-screen 
instructions to create an account.

4 If you have an account, click Sign in now.

If you signed in to a valid account, the FLICKR authorization window appears.
If you want to change to a different FLICKR account, click Unauthorize and repeat this 
step.

5 After setting up your FLICKR account, click OK, I’ll allow it. Your frame can now 
access FLICKR photo feeds wirelessly.

You return to the FLICKR page with your sign in confirmation.
To add new FLICKR feeds, click the Photo RSS tab (see page 17).

2
3

4

Sign in 
confirmation

5
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Setting up Web content
Connecting to your FRAMECHANNEL account
Connect your frame to your FRAMECHANNEL account so you can view, create, and 
manage additional customized feeds such as news, weather, sports scores, and 
finance.

1 Follow the steps on page 11 to access the Device Settings Web page.

2 Click the FRAMECHANNEL tab.

The FRAMECHANNEL page appears.

3 If you don’t have a FRAMECHANNEL account, click the link and follow the 
on-screen instructions to create one.

4 When you are finished setting up your FRAMECHANNEL account, or if you already 
have one, sign in, then enjoy the benefits of having an account: 

■ access and customize free photo-sharing sites, and add them to your frame for 
viewing

■ preview contents of your frame right on the FRAMECHANNEL page

■ view and manage your favorite photos and photo-sharing sites

■ add new FRAMECHANNEL feeds; click the Add button (see page 19)

2

3

www.kodak.com/go/support  16



Setting up Web content
Adding Web feeds
Set up your frame to view RSS (Really Simple Syndication) photo feeds directly from 
FLICKR, FRAMECHANNEL, and other favorite sites.

IMPORTANT: Your frame can play only feeds that contain photos. An error message 
appears when you try to play feeds that are text only. Make sure you 
preview your feeds after they are added to the Device Settings page. You 
can edit or delete them there. See page 24.

NOTE: Preloaded and new feeds are added to the feeds list under the sites’ tabs on the Device Settings 
Web page, where you can preview, edit, or delete them, see page 24. They appear also in the Web 
media list on your frame’s Home screen where you can play them, see page 27. 

How to add a FLICKR feed
1 Follow the steps on page 11 to access the Device Settings Web page.

2 If you don’t have a FLICKR account, create one now (see page 15), then continue 
with step 3 below.

3 Click the Photo RSS tab.

The Photo RSS/FLICKR page appears with a list of preloaded FLICKR feeds that are on 
your frame.

4 Click Add.

3

4
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Setting up Web content
The Photo RSS/FLICKR Add/Edit page appears.

NOTE: You can edit preloaded feeds here (such as FLICKR: Interesting photos) and feeds you add. (See 
page 24.)

5 In the Site drop-down menu, keep FLICKR as the default site.

6 Enter a tag (keyword) for the types of photos you want to see.

NOTE: FLICKR automatically sends pictures matching the tag directly to your frame. 

7 Click in the Photo feed name box to automatically assign the tag to the FLICKR 
feed name.

8 Click Save.

Congratulations, you have completed your FLICKR photo feed setup! The feed name is 
added to the list of feeds on the FLICKR page and to the Web media list on your 
frame’s Home screen. (See page 27.) 

To create a shortcut of your feed on the Home screen, see page 23.

NOTE: Preview your feed to make sure it will play on your frame. (See page 24.)

5

6

7

8
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Setting up Web content
How to add a FRAMECHANNEL feed
1 Follow the steps on page 11 to access the Device Settings Web page.

2 Click the FRAMECHANNEL tab.

The FRAMECHANNEL page appears with a list of preloaded FRAMECHANNEL feeds that 
are on your frame.

3 If you don’t have a FRAMECHANNEL account, click the link and follow the 
on-screen instructions to create one.

IMPORTANT: Creating an account links FRAMECHANNEL to your frame so you can view, 
create, and manage customized feeds such as news, weather, sports scores, 
traffic, and much more. You can click the FRAMECHANNEL logo to access 
these and other free photo-sharing sites for viewing right on your frame.

4 Click Add.

2
3

4

FRAMECHANNEL logo
19 www.kodak.com/go/support



Setting up Web content
The FRAMECHANNEL Add/Edit page appears.

5 From the Category drop-down menu, select the type of content you want to see 
from FRAMECHANNEL (news, weather, sports, finance, etc.)

6 You can change the photo feed name (category included) that appears 
automatically.

7 Click Save.

Congratulations, you have completed your FRAMECHANNEL photo feed setup! The 
feed name is added to the list of feeds on the FRAMECHANNEL page and to the Web 
media list on your frame’s Home screen. See page 27.

To create a shortcut of your feed on the Home screen, see page 23.

NOTE: Preview your feed to make sure it will play on your frame. See page 24.

6

5

7
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Setting up Web content
How to add feeds from other sites
1 Follow the steps on page 11 to access the Device Settings Web page.

2 Click the Photo RSS tab.

The Photo RSS/FLICKR page appears with a list of preloaded feeds that are on your 
frame.

3 Click Add.

The Photo RSS/FLICKR Add/Edit page appears.

NOTE: You can edit preloaded feeds here (such as FLICKR: Interesting photos) and feeds you add from 
other sites. (See page 24.)

4 In the Site drop-down menu, select Other.

5 In a new window on your computer, navigate to a photo RSS feed on the Internet 
(photo sites only). Highlight the complete RSS feed URL in the address bar.

6 Copy and paste the URL into the URL box on the Photo RSS/FLICKR Add/Edit page.

The URL of the photo RSS feed is automatically entered in the Photo feed name box.

7 Click in the Photo feed name box to edit the name.

2

3

Photo RSS/FLICKR page

Photo RSS/FLICKR Add/Edit page

7

4

6
8
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Setting up Web content
8 Click Save.

Congratulations, you have completed your photo feed setup! The feed name is added 
to the list of feeds on the Photo/RSS page and to the Web media list on your frame’s 
Home screen. (See page 27.) 

To create a shortcut of your feed on the Home screen, see page 23.

NOTE: Preview your feed to make sure it will play on your frame. (See page 24.)
www.kodak.com/go/support  22



Setting up Web content
Creating shortcuts on your frame
Create up to five shortcuts to easily access your favorite Web media (such as KODAK 
Gallery, FLICKR, and FRAMECHANNEL) right from your frame’s Home screen.

1 Follow the steps on page 11 to access the Device Settings Web page.

2 Click the Create Shortcuts tab.

The Web Media shortcuts page appears with a list of photo feeds that are on your 
frame (including feeds you create as shortcuts).

3 Click the icon  next to the feed you want to create as a shortcut (five shortcuts, 
maximum).

The icon is highlighted  and the shortcut to the feed immediately appears on the 
Home screen. See page 27.

To remove a shortcut, click the highlighted icon to disable it.

The shortcut is removed from the Home screen.
Removing the shortcut only deletes the icon from the Home screen; it does not remove 
the feed from the list or from the Web Media list on the frame’s Home screen.

2
3
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Setting up Web content
Previewing, editing, and deleting feeds
Preview, edit, or delete feeds (preloaded or feeds that you add) on the 
FRAMECHANNEL, FLICKR, or Photo/RSS pages. 

IMPORTANT: Your frame plays only feeds that contain photos. An error message appears 
when you try to play feeds that are text only; so, make sure you preview 
your feeds after they are added on the Device Settings page.

To preview a feed, click  next to the feed name on the FRAMECHANNEL or 
Photo/RSS page.

To edit a feed, click  next to the feed name. 

■ For FLICKR feeds, the tag name is highlighted and the text is erased when you type 
the first character of the new tag name. 

■ For FRAMECHANNEL feeds, you can select another category or change the photo 
feed name that is associated with the category.

To delete a feed, click  next to the feed name. A confirmation message 
appears. Click Delete.

Preview Edit Delete

Photo RSS page

FRAMECHANNEL page
www.kodak.com/go/support  24



4 Viewing locally on your frame

View pictures from your frame’s internal memory or any connected picture source 
(memory card, camera, USB device). 

For viewing Web content, see Viewing in wireless mode, page 36.

Enjoying your pictures immediately!
■ To view your pictures or play a slide show, 

insert a memory card, or connect a camera or other 
USB device (see page 26). Your pictures play 
automatically.

If your frame has pre-loaded sample pictures, they start 
playing automatically.

To maximize your frame’s internal memory, delete 
the pre-loaded samples. Access them in Pictures & 
Videos → Internal memory (page 28), then see 
page 53 to delete them.
25 www.kodak.com/go/support



Viewing locally on your frame
Inserting a memory card

Connecting a digital camera or other USB device

MULTIMEDIA Card

To insert a card, push it firmly into the 
slot until it clicks and stops.

To remove a card, push it in to release 
it, then pull it out of the slot.

Important: Do 
not insert a micro 
or mini memory 
card without an 
adapter (sold 
separately).

xD

SECURE DIGITAL/SDHC
MEMORY STICK

USB cable included 
with your USB device

USB devices: camera, flash drive, card 
reader, computer, etc. (sold separately)
www.kodak.com/go/support  26



Viewing locally on your frame
Viewing the Home screen
Start at the Home screen to access your pictures & videos, music, Web content, 
shortcuts to your Web feeds, and the Settings menus.

1 Tap  (Home). If the icons are not visible, tap the 
Quick Touch Borders.

2 Tap the border below one of the icons along the 
bottom of the screen.

3 Tap  (Close) to dismiss the icons.

Home screen icons

Home screen icons:

Pictures and videos (see Viewing your pictures and videos, page 28)

 Music (see Playing music, page 48)

Web 
content

For viewing Web content such as Web Media, KODAK Gallery, FLICKR and 
FRAMECHANNEL feeds, News, Weather, Sports, and any shortcuts you create 
(see Viewing Gallery/Web media content on your frame, page 38.)

Settings—customize frame settings such as slide show durations and transitions, 
viewing options, screen brightness, clock, and timer (see Changing settings and 
more, page 55).
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Viewing locally on your frame
Viewing your pictures and videos
View your pictures, videos, and music from the frame’s internal memory or any 
connected picture source or wireless network computer.

1 Tap  (Home), then  (Pictures and 
Videos).
All connected sources are displayed.

2 Slide or tap below the arrows to highlight a picture 
source, then:

■ Tap  (Play slide show) on the right border to 
start a slide show of the pictures in the 
highlighted source. 

■ Or, tap OK to view thumbnails, folders, etc. 

 
 

Picture source icons

Picture sources:

Internal memory—the frame’s 2 GB internal memory. Copy your pictures into internal 
memory from a memory card or other device.

Memory card—appears when you insert a card (page 26). The label and icon indicate 
the type of card.

Camera—appears when you connect a digital camera via USB cable (page 26).

USB drive—appears when you insert a USB flash drive (page 26).

Home PC—appears if you are connected to a wireless network computer. View 
pictures that are stored on the computer (see page 37).

My Slide show—appears when you save a picture source as a default slide show for 
quick access anytime (see page 31).
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Viewing locally on your frame
Viewing thumbnails
There are three ways to view your pictures as thumbnails:

■ Tap  (Home) →  (Pictures and Videos), 
then select a picture source (see page 28).

Tap OK.

OR

■ From a slide show, tap the touch border to display 
the icons, then tap  (Thumbnails).

■ From single view, tap  (Thumbnails).

Tips when viewing thumbnails:

■ To navigate through the thumbnails, slide your finger left/right along the slider at 
the bottom, or tap below the slider arrows to move one picture at a time.

■ To move even faster through the thumbnails, touch and hold until the slide control 
changes (about 3 seconds), then slide.

■ To play a folder of images, highlight the folder then tap  (Play slide show).

■ To play a video from thumbnails view, highlight a video thumbnail ( ). Tap OK 
or  (Play slide show).

Picture source, selected

Tap Thumbnails

Pictures are displayed as thumbnails
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Viewing locally on your frame
Viewing a single picture
■ To view a single, full-screen picture, highlight it in thumbnails view, then tap 

OK. If a slide show is playing, tap the Quick Touch Border (upper right or bottom) 
when the picture appears, then tap  (Close) to hide the icons and lights, and 

view full screen.

■ To rotate a single view picture, tap  (Actions), then keep tapping  
(Rotate) until you get the desired orientation.

■ To magnify a single view picture up to 8X, tap 

 (Actions), then tap  (Zoom). Slide under 
the zoom bar from left to right towards the plus (+) 
sign. 

To view other parts of the magnified picture, tap the 
arrows. To return to 1X, slide from right to left 
towards the minus (-) sign.

NOTE: The zoom level depends on image size. You can zoom in more 
with higher resolution images.
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Viewing locally on your frame
Playing a slide show
There are two ways to start a slide show on your frame:

■ Insert a card or connect a USB device—a new slide show starts automatically, 
replacing a currently running slide show or single view picture. 

■ Highlight a picture folder in thumbnails view (see page 29), or highlight a picture 
source on the Pictures and Videos screen, then tap  (Play slide show).

NOTE: Music and videos in the same picture source play automatically during a slide show. 
To add music to a slide show, see page 48. 

Other slide show information

■ A slide show plays continuously until you stop it or turn off the frame.

■ You can change the slide duration and transition style (see page 55).

■ Set your frame to play sound from a captured video, or play music (if available and 
selected) when videos are played. See Audio priority, page 56.

■ While viewing a slide show, you can change the slide show settings. Tap a Quick 
Touch Border to display the icons, then tap  (Slide show options). For more 
details about the settings, see page 56.

Saving your favorite slide show for easy access

Save access to favorite pictures as My Slide show. While viewing a slide show:

1 Tap a Quick Touch Border to pause the slide show and to display the screen icons.

2 Tap  (Slide show options) → Save as My Slide show. Tap Yes to confirm.

NOTE: My Slide show plays automatically when you turn on your frame. The My Slide show icon  
appears on the Pictures and Videos screen as a picture source (see page 28).
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Viewing locally on your frame
Changing Slide show options
The Slide show options let you customize how you view and play slide shows on your 
frame.

1 While viewing a slide show, tap a Quick Touch Border to pause the slide show and 
to display the screen icons.

2 Tap  (Slide show options).

3 Slide, or tap below the slider arrows, to highlight an option, then tap Select. 

IMPORTANT: You may need to keep sliding to see a complete list of available options.

4 Follow the on-screen instructions. Tap Save to accept your selections.

5 Tap  (Back) to exit.

Slide show options

Save as My Slide show See Saving your favorite slide show for easy access, page 31.

Sort See Arranging pictures to play by date or filename, page 35.

Background music See Notes on playing, copying, deleting music:, page 48.

These slide show options are 
also available in the Settings 
menus. For details, see 
page 55 and page 56.

Slide duration
Transitions
Shuffle
Slide show starting point
Screen Fit or Fill
Music auto-play
Audio priority
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Viewing locally on your frame
Creating a multimedia slide show
Use KODAK EASYSHARE Digital Display Software to create a multimedia slide show 
with pictures and music. Then copy the slide show to your frame.

Before you proceed, make sure you install the software packaged with your frame (see 
page 8).

1 Double-click  (KODAK EASYSHARE Digital Display Software icon) on your 
desktop to open the software.

2 Click the Slide Show Editor tab.

Pictures/videos 
on your 
computer

Select pictures 
here (Viewer 
Pane)

Drag and drop 
music and pictures

Click Help 
for more 
info

Click Slide Show 
Editor

KODAK EASYSHARE Digital Display Software
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Viewing locally on your frame
3 In Picture & Videos, click the folder or location that contains the files you want to 
add to the slide show.

4 In the Viewer pane, select the pictures, videos, or music, then drag and drop them 
to the Slide Show Editor. Drag pictures in the Editor to change the order.

5 Click Save. In the Save Slide Show window, enter a new name in the text box, then 
click Save.

The multimedia slide show is listed in the left navigation pane under Slide Shows.

For more details on creating multimedia slide shows in Digital Display Software, 
click Help.

Copying a multimedia slide show to your frame
Use Digital Display Software on your computer to copy your multimedia slide shows to 
your frame.

1 In the navigation pane under Slide Show, click a multimedia slide show.

2 Drag the slide show to your frame in the Drag & Drop Zone.

For more details on copying from Digital Display Software to your frame, click THE 
Help or see page 44 in this guide.
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Viewing locally on your frame
Arranging pictures to play by date or filename
The pictures on your frame are arranged and played by date, starting with the oldest. 
You can play the arrangement or order by date or alphabetically by filename.

To change the sort order:

1 While viewing a slide show, tap a Quick Touch Border to pause the slide show and 
to display the screen icons.

2 Tap  (Slide show options).

3 Highlight Sort, then tap Select.

4 Highlight a sort order:

-Filename, A to Z

-Filename, Z to A

-Date, oldest to newest

-Date, newest to oldest

5 Tap Save.
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5 Viewing in wireless mode

Make sure your frame is connected to your home wireless network and set up to 
display Web content. See Chapter 2, Setting up for wireless operation and Chapter 3, 
Setting up Web content.

What can I do in wireless mode?

For more information about wireless technology, visit www.kodak.com/go/wifisupport 
or www.wi-fi.org.

For viewing pictures from your frame’s internal memory, or any connected picture 
source, see Chapter 4, Viewing locally on your frame.

Display pictures on your frame directly from your computer hard drive page 37

Display Web content you set up page 38

Display pictures from your KODAK Gallery account page 39

Automatically receive pictures from your friends and family at the Gallery page 40

Email pictures/videos directly from your frame to friends and family page 42

Copy pictures wirelessly from your frame to your computer page 44

Automatically upgrade your firmware from the Internet page 59
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Viewing in wireless mode
Viewing pictures from your computer
View pictures and videos from your computer right on your frame—wirelessly.

IMPORTANT: Make sure you install the software that came with your frame (page 8) and 
connect to your wireless home network (page 5).

1 On your frame, tap  (Home) →  (Pictures and Videos).

2 Highlight your computer, , then tap OK.

It may take up to 10 seconds for your computer to 
appear on the Pictures and Videos screen.

If your computer is not listed, go to troubleshooting 
help on page 63.

NOTE: If you have more than one frame on your wireless network, give them unique names using the 
on-screen keyboard so you can tell them apart. Go to Home → Settings → Device configuration 
menu. See page 57.

NOTE: The first time you connect, a message may appear on your computer screen alerting you to a new 
device. Follow the prompts to “allow” the frame on your computer.

3 Highlight the category of pictures (such as Pictures and Videos, StoryShare Albums, 
and New Picture Chronicles) that you want to view, then tap OK.

All Pictures and Videos displays every picture and video that your computer is sharing, 
without showing folders. The categories are established by the EASYSHARE Digital 
Display Software (see page 44).

4 Pictures are displayed as thumbnails. See Viewing thumbnails, page 29 for all the 
ways you can enjoy your pictures, videos, and music on your frame.
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Viewing in wireless mode
Viewing Gallery/Web media content on your frame
Follow the instructions in Chapter 3, Setting up Web content, to prepare your frame 
to display your favorite KODAK Gallery albums and RSS feeds from the Web. Then do 
the following:

1 Tap  (Home).

2 On the Quick Touch Border, tap the light below a 
Web source to view its content.

Web sources on the Home screen, including your shortcuts:

Web sources

Web media—list of all the RSS photo feeds that are on your frame.

KODAK Gallery—appears if you set up access to KODAK Gallery and create a shortcut. 
Display your Gallery albums and My Friends’ Albums. The number in the corner 
indicates someone has shared albums with you at the Gallery! See page 40. 

FLICKR service—preloaded (including Interesting photos) and new FLICKR feeds that 
you set up.

FRAMECHANNEL service—appears if you create shortcuts for FRAMECHANNEL feeds 
from favorite photo-sharing sites (see page 23).

News Weather Sports—preloaded feeds from FRAMECHANNEL that you can manage 
and customize.
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Viewing in wireless mode
Viewing Web feeds on your frame
Wirelessly view preloaded RSS feeds or feeds you set up of frequently changing Web 
content such as FLICKR or FRAMECHANNEL public photos, news, weather, sports, 
finance, etc.

1 From the Home screen, tap  (Web media). To start a slide show, slide to 
highlight a feed from the list, then tap  (Play slide show).

2 To pause a slide show and display the icons, tap a touch-sensitive area on the 
Quick Touch Borders (upper right or bottom) during the slide show.

To hide the icons and lights and view the full screen, tap  (Close).

To restart the slide show, tap a touch-sensitive area on the Quick Touch Borders 
(upper right or bottom) to display the icons, then tap  (Play slide show).

Viewing KODAK Gallery pictures
View Gallery pictures and albums wirelessly right on your frame.

NOTE: Connection to KODAK Gallery is currently limited to customers in the United States, Canada, and 
Europe.

To see all pictures from the Gallery: 

1 Tap  (Home), then highlight  (KODAK Gallery). Select your Album, then 
tap OK.

2 Highlight Play all, then tap OK to see the pictures as thumbnails. Or, tap  (Play 

slide show) to view them as a slide show.

See Chapter 4, Viewing locally on your frame for all the ways you can enjoy your 
Gallery pictures on your frame.

NOTE: Gallery features not supported on your frame at this time: viewing videos, printing or deleting 
pictures.
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Viewing in wireless mode
Automatically receiving My Friends Albums
IMPORTANT: Make sure you install the software that came with your frame (page 8) and 

connect to your wireless home network (page 5).

Your wireless frame uses Kodak’s Picture Mail feature to notify you automatically 
when a friend shares pictures with you at the KODAK Gallery. Play a slide show of the 
new pictures, right on your frame, even before you see the email on your computer! 

To see the shared pictures right away:
1 When the notice  appears on the frame screen, 

tap below View now.
A slide show of the new pictures plays on your frame.
If there are multiple albums you haven’t viewed yet, 
select a marked album  from the Gallery list and 
tap OK.

To see the shared pictures later:
1 When the notice  appears on the frame screen, 

tap below Dismiss.

2 To see the new pictures, tap  (Home), then tap 

 (KODAK Gallery).

The number on the Gallery icon (7 in this example) 
indicates how many unviewed albums are available.

3 With My Friends’ Albums highlighted, tap OK. 

4 To view a My Friends album as a slide show, 
highlight the album, then tap  (Play slide show). 

Or, tap OK to see the pictures as thumbnails.
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Viewing in wireless mode
Turning off auto-receive and notification

You can turn off auto-receive and/or notification from your friends’ albums at the 
Gallery from the Home screen (see below) or from the Display Settings Web page (see 
page 14).

1 Tap  (Home),  (Settings), then tap OK.

2 Tap KODAK Gallery, then tap Select.

3 Highlight Picture Mail, then tap Select.

4 Choose from these options:

Auto-receive with notification ON—(default) you automatically receive your 
friends’ albums and the notice appears on the frame.

Auto-receive ON—you automatically receive your friends’ albums on your 
frame, but the notice does not appear on the frame. You know when your friends 
send you pictures because the email icon  still appears on the KODAK Gallery 

on the Home screen, and on unviewed My Friends’ Albums in your Gallery 
account.

Auto-receive OFF—you don’t automatically receive your friends’ albums on 
your frame. To view them, see Viewing KODAK Gallery pictures, page 39.
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Viewing in wireless mode
Emailing pictures and videos from your frame
Use the Share feature to email pictures and videos to family and friends—directly 
from your frame.

IMPORTANT: Make sure you install the software that came with your frame (page 8) and 
connect to your wireless home network (page 5).

Adding a new email address
1 Choose a picture source, then tap (Actions).

2 Tap  (Share), then tap Add name.

The onscreen keyboard appears.

3 Enter the email address:

Highlight a character, then tap  (Select) to enter it in the text box. (To highlight 
a character, slide along the bottom of the touch border or tap below the slider 
arrows.) Repeat for each character of your email address, then tap Save.

4 Assign a nickname to the new email address (optional).

Select

Text box

Slider
Slider arrows

Save

Backspace
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Viewing in wireless mode
Emailing your pictures
1 Highlight a picture in thumbnails (page 29) or single view (page 30).

To select multiple pictures, see page 54.

2 Tap (Actions), then tap  (Share).

The email addresses and nicknames you created are listed. The album name and 
number of pictures you selected are also displayed.

3 Slide to highlight an email address. Tap  (Share).

A progress bar appears with the number of shared pictures and the upload destination. 
If the destination is your Gallery account, the entire album is uploaded.

Other emailing information:

■ Follow the prompts to add a new address before you send the email (see page 42).

■ To send the pictures to multiple addresses, highlight an address and tap  
(Select) for each address, then tap  (Share) to send all at once.

■ Tap  (Select all) to send to everyone on your list.
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Viewing in wireless mode
Copying wirelessly to/from your computer
The KODAK EASYSHARE Digital Display Software (included on the CD that was 
packaged with your frame) lets you drag and drop (copy) pictures, videos, and music 
wirelessly between your frame and computer or other connected devices (page 26).

Before you proceed:

1 Make sure you install the software that came with your frame (page 8). Connect to 
your wireless home network (page 5), then verify your computer connection 
(page 10).

Your frame can now access the content on your host computer, wirelessly.
NOTE: If you have more than one frame on your wireless network, give them unique names so you can tell 

them apart. Go to Home → Settings → Device configuration menu, see page 57.

2 Make sure the USB connection mode on your frame is set to Computer (see 
page 51).

3 Double-click  (KODAK EASYSHARE Digital Display Software icon) on your 
desktop to open the software.

The frame, memory card, and connected devices (see page 26) appear in the Drag and 
Drop Zone.
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Viewing in wireless mode
Proceed with copying:

1 Click My Devices to see the folders on your frame and connected devices 
(page 26).

The frame appears as removable drives—one drive for each connected picture source in 
the frame: internal memory, memory cards, USB devices.

2 Click Pictures and Videos or My Devices to find the pictures, videos, etc. you want 
to copy. 

3 In the Viewer pane, select the pictures, videos, etc., then drag and drop them to 

Pictures/videos 
on your 
computer

- your wireless 
frame 

Select pictures 
here (Viewer 
Pane)

Drag and drop 
here (Drag and 
Drop Zone)

Click Help 
for more 
info

Click here to 
create a slide 
show

My Devices:

- connected USB 
devices

Music

KODAK EASYSHARE Digital Display Software
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Viewing in wireless mode
the new location in the Drag and Drop Zone (for example, the frame’s internal 
memory, a memory card, computer, or connected USB device).

4 Go to the copy location to view your copied pictures, videos, etc. or to play a slide 
show on your frame.

NOTE: The slide show order of play for available sources is: memory card, USB device, internal memory.

To maintain the slide show order during playback, see page 35 and select Filename, A - Z.

Copying pictures from EASYSHARE Software
It’s easy to copy pictures/videos from My Collection to your frame.

1 Install the software that came with your frame (see page 8).

2 Set the USB connection mode to Computer (see page 51). 

3 Double-click  (KODAK EASYSHARE Software) on your desktop to open the 
software. 

File → Copy to Select pictures here Drag and drop to Picture tray

My 
Collection

KODAK EASYSHARE Software
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Viewing in wireless mode
4 Click My Collection, then select the pictures in the Viewer pane. Drag and drop 
them into the Picture tray.

5 In the menu bar, select File → Copy to.

The frame appears as removable drives—one drive for each connected picture source in 
the frame: internal memory, memory cards, USB devices.

6 Browse to the frame location to which you are copying.

7 Select Best For Digital Picture Frame to resize the picture you are copying. Full 
resolution is unnecessary and quickly fills up the frame’s memory. 

8 Click Copy. Pictures are copied to your frame.

9 Go to the copy location to view your copied pictures on your frame and to play a 
slide show.
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6 Doing more with your frame

Playing music
1 Tap  (Home), then  (Music).

All connected sources that contain music files are listed 
(memory card, USB device, network computer, etc.)

2 Slide to highlight a source, then tap OK. 

3 Continue to navigate through any folders or 
categories until the songs are listed.

4 Slide to the right/left to move up/down the music 
list, then tap OK.

5 Slide right/left to go to the previous/next song, or tap Select all, then tap the Play 
button on the bottom of the border to start playing music.

6 Tap  (Play slide show) on the right border to return to your slide show.

NOTE: Music plays automatically when a memory card or USB device with music on it is connected. To 
prevent music from playing automatically, tap Home > Settings > Viewing Options > Music 
auto-play > Off.

Notes on playing, copying, deleting music:

■ To add background music while a slide show is playing, touch the border to display 
the icons. Tap Slide show options > Background music, then tap Select.

■ A headphone jack is available on the side of the frame (page ii).

■ Adjust the frame volume with the Volume button (see page ii). The on-screen 
volume indicator appears in the upper right. 

■ While music is playing, tap  (Audio Options) to turn on/off Shuffle Play and 
to set Audio presets and Audio priority. For more details, see page 56.

Play/Pause button
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Doing more with your frame
■ To copy or delete music files (MP3), highlight the songs in the music source, then 
tap  (Actions) → Copy or Delete → OK.

-To copy, tap under the destination icon where you want to copy your music.

-To delete, tap Yes to confirm the deletion.

■ To copy music files (MP3) from your computer to your frame’s internal memory, 
drag and drop them from your computer. See Copying wirelessly to/from your 
computer, page 44.

Playing a video
■ During a slide show, videos play automatically. When the video ends, the slide 

show advances to the next picture or video. To play a video from thumbnails view, 
highlight a video thumbnail, then tap OK.

■ Videos in thumbnail view:

– MOV videos are indicated with . 

– AVI, MPEG, and MPG videos display the first frame.

■ Video control icons (on bottom border):

NOTE: HD (high definition) video files are not supported. Video formats created with digital cameras are 
certified for KODAK Digital Frames. Videos created with or copied from other sources may not play 
on your frame.

NOTE: To play the audio portion of a video while you are playing music, change the Audio priority in Slide 
show options (see page 56).

play, pause, and resume the video.

rewind / fast forward.

or  stop the video and return to thumbnails.
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Doing more with your frame
Printing pictures
NOTE: The print icon is available on your frame when you connect your printer.

Your frame is compatible with PICTBRIDGE Technology, so you can print directly to 
PICTBRIDGE enabled Printers.

1 Turn off the frame and printer.

2 Make sure your frame is disconnected from the 
printer.

3 Turn on the frame, then change your connection 
mode on your frame from Computer to Printer. See 
page 51.

4 Reconnect your frame to the printer, using the USB 
cable.

Printing to a PICTBRIDGE enabled Printer
1 Turn on the printer. Turn on the frame.

2 From a slide show (tap the touch-sensitive border to pause the slide show and 
display the icons) or from single view:

■ Tap  (Actions), then tap  (Print).

The current picture begins printing.

If you are in thumbnails (multi-up) view:

■ Slide to select a picture, or see page 54 to select multiple pictures.

■ Tap  (Actions).

If you selected multiple pictures to print, the pictures and number of selected pictures 
appear on the screen.

■ Tap  (Print), then Yes to start printing all selected pictures.

NOTE: Remember to change your connection mode back to Computer when you are done (see page 51).
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Doing more with your frame
Manually changing USB connection mode
The connection mode must match the device to which you connect the frame: 
Computer or Printer. The default is Connect to computer. You can change the 
connection mode.

1 Disconnect the printer or computer from the frame.

2 On the frame, tap  (Home), then tap  (Settings).

3 Slide to highlight Device configuration, then tap Select.

4 Highlight USB connection mode, then tap Select.

5 Slide to highlight the mode you want to connect to, printer or computer, then tap 
Save.

6 Reconnect the device (printer or computer) that matches the connection mode in 
step 5.
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Doing more with your frame
Copying on your frame
Copy pictures from your current viewing location to other connected devices (see 
page 26).

CAUTION:
Removing a card or disconnecting a device while copying may 
damage your card, pictures, or device.

1 Highlight a picture to copy:
In thumbnails view, slide or tap below the slider 
arrows to find a picture; or, display a picture in 
single view (see page 30).

To select multiple pictures, see page 54.

2 Tap  (Actions), then tap  (Copy).

3 Tap under the destination icon where you want to copy your picture.

The picture is copied.

4 Tap OK to dismiss the screen.

NOTE: To copy wirelessly between your frame and computer, see page 44.
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Doing more with your frame
Deleting pictures

CAUTION:
Removing a card or disconnecting a device while deleting may 
damage your card, pictures, or device.

1 Highlight a picture to delete:
In thumbnails view, slide or tap below the slider 
arrows to find a picture; or, display a picture in 
single view.

To select multiple pictures, see page 54.

2 Tap  (Actions).

3 Tap  (Delete), then tap Yes to confirm.

The picture is deleted.

4 Tap OK to dismiss the screen.
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Doing more with your frame
Selecting multiple pictures
Use the multi-select feature to copy or delete two or more pictures or to play a slide 
show of selected pictures.

1 In thumbnails view (see page 29), slide or tap below the slider arrows to find a 
picture, then tap  (Select).

A check mark appears on the selected picture.

2 Continue selecting pictures.

To remove a check mark, tap  (Unselect) while the picture is highlighted. 

To quickly unselect many pictures, tap Select All, then Unselect All.

Select/Unselect all
Select all

■ In thumbnails view (page 29), tap  (Select 
All).

Unselect all

■ To remove all check marks, tap Unselect All.
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7 Changing settings and more

Changing frame settings
The options in the Settings menu let you customize and configure your frame.

1 Tap  (Home), then  (Settings).

2 Slide or tap below the slider arrows to highlight a setting, then tap Select. 

IMPORTANT: You may need to keep sliding to see a complete list of available options.

3 Follow the on-screen instructions. Tap Save to accept your selections.

4 Tap  (Back) to exit.

Settings menus
Setting Options

Upgrade firmware
This option is only displayed if 
the upgrade file (.img) is 
available on the frame 
(memory card, flash drive, 
internal memory, etc.).

Upgrade firmware—load the latest version of firmware on 
your frame (page 59). 
Exit—return to the Home screen.

Viewing options Slide duration—specify how long each picture is displayed 
in a slide show, from 3 seconds to 5 minutes. (The default is 5 
seconds.)
Transitions—specify the transition style between pictures in 
a slide show. See screen for options. The default is Random.
Shuffle—plays the images in random order.
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Changing settings and more
Viewing options
(continued)

Slide show starting point—when pictures are sorted from 
oldest to newest (see page 35), specify where a slide show 
starts automatically (your most recent week of pictures, or 
from oldest picture).
Brightness—your frame automatically adjusts the screen 
brightness for room conditions (default). To turn off 
auto-adjust, click Disable; slide to manually adjust the screen 
brightness.
Frame orientation—display your frame in landscape 
(default)  or portrait  orientation.
Screen Fit or Fill—
Fit entire image  (default). Show the entire picture. 
Black borders may appear around the image. 
Fill the screen .The picture fills the entire screen; some 
of the picture may be cut off (cropped).
Audio preset—specify the type of music you usually play. 
The audio output is optimized (equalized) for that type. The 
default is Standard.
Music auto-play—choose to play music automatically 
during a slide show. (Music files must be in the same location 
as your pictures.)
Audio priority—when you are playing music (page 48), 
choose whether or not to play the audio portion of a video. 
Play music (default). Music continues to play, video plays but 
its audio is muted. Play video sound track. Music stops 
playing while the video, with audio, plays.
KODAK PERFECT TOUCH—automatically enhances your 
pictures to look their best on your frame. The default is On.
KODAK logo—set the lighted Kodak logo on the front of the 
frame. Keep on (default). The logo stays on whenever the 
frame is on. Fade away. The logo turns off after start up 
(takes effect the next time you turn off/turn on your frame).

Setting Options
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Clock and timer On/Off schedule—set your frame to turn on and off at a 
specified time every day (page 58).
Set time—manually set the clock to the current time 
(page 58).

KODAK Gallery Specify your country, email address, and password. 
First, install the software (page 8) and set up access to the 
KODAK Gallery (page 11).

Network Set up your frame for wireless operation. See page 5.

Device configuration Frame name—use the on-screen keyboard to assign a name 
to your frame. This name is referenced when connecting to 
your wireless network. If you have more than one frame on 
your wireless network, give them unique names so you can tell 
them apart.
USB connection mode—before you connect a USB 
computer or printer, choose Computer (default) or Printer. 
See page 51.
RSS feeds—a list of feeds you set up to view on your frame 
using the EASYSHARE Digital Display Software. Edit RSS feeds 
from your computer using the software. See page 24.
Frame connections—choose how your frame works with 
other devices. Share frame content: choose to turn off or 
allow devices (such as computers or other wireless frames) to 
access your frame contents; Remote setup: specify whether 
or not to allow your frame to be set up from your computer; 
Remote copy: turn off or allow copying to your frame from 
your computer; Remote copy destination: specify a default 
destination on your frame (internal memory, SD card, etc.) to 
save your copied pictures.

Language Choose your language (page 4).

Setting Options
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Setting the clock and timer
Manually setting the clock
1 Tap  (Home), then tap  (Settings).

2 Highlight Clock and timer, then tap Select.

3 Highlight Set time, then tap Select.

4 Slide to set the hour. Tap the Next arrow to highlight the next setting (minutes), 
then slide to adjust it.

5 Tap Save to accept your changes.

Getting the time from the Internet
1 Tap  (Home), then tap  (Settings).

2 Highlight Clock and timer, then tap Select.

3 Highlight Get time from Internet, then tap Select.

4 Highlight Turn on, then tap Select.

5 Highlight a Time Zone, then tap Save to accept your changes.

Setting automatic on/off
Set your frame to turn on and off at a specified time every day.

NOTE: Set the clock before enabling auto on/off.

1 Tap  (Home), then tap  (Settings).

Automatic resizing Choose to turn on or off automatic resizing of your pictures 
when copying. Full resolution is unnecessary for viewing and 
quickly fills up the frame’s memory. Choose full resolution for 
printing.

About Check your frame model, serial number, and firmware version.

Setting Options
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2 Highlight Clock and timer, then tap Select.

3 Highlight On/Off schedule, then tap Select.

The current time is displayed and the hour field is highlighted.

4 Set the Turn on time. Slide to adjust the hour. Tap the Next arrow to highlight the 
next setting (minutes), then slide to adjust it. Repeat to set Turn off time.

NOTE: Make sure the on time is earlier than the off time.

5 Tap Enable, then tap Save when you’re done.

Your frame will now automatically turn on and off at the times you specified.

If your frame loses power, the clock time returns to the factory setting and the 
automatic on/off times, if set, are disabled. To reset the clock and re-enable your 
on/off times, see Resetting the clock after losing power, page 66.

Upgrading your firmware (recommended)
Firmware is the software that runs on your frame. To check for the latest version, visit 
www.kodak.com/go/digitalframedownloads.

Automatically upgrade firmware from the Internet
When the frame is connected to your wireless network, you receive an automatic 
notice from the Internet whenever a new firmware version is available for your frame.

When the notice appears, select one of the screen options:

■ Install now (to upgrade right away)—Select, then press OK to start the upgrade.

When the upgrade is complete, your frame automatically restarts. If it doesn’t, press the 
power switch on the frame to Off, then back to On.

IMPORTANT: Do not turn off the frame during the upgrade!

■ Remind me later (to upgrade later)—Select, then press OK.

The upgrade message disappears, then appears again the next time you turn on the 
frame.

■ No thanks (to dismiss the message)—Select, then press OK.
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The upgrade message disappears. You will not be reminded again about this firmware 
version. A new message appears when the next firmware version is available.
To change your mind and upgrade to this firmware version at your convenience, see 
Manually upgrade firmware, page 60.

Manually upgrade firmware
Download the firmware to your computer, then upgrade your frame:

1 On your computer, go to www.kodak.com/go/digitalframedownloads.

2 Follow the screen directions to download the frame firmware to your computer.

3 Copy the IMG file to the root directory (not in a folder or subfolder) of a memory 
card or USB flash drive, then insert into the frame. See page 52 for copying files.

4 Tap  (Home), then tap  (Settings).

5 Highlight Firmware Upgrade, then tap OK to begin the upgrade.

IMPORTANT: Do not turn off the frame or remove the memory card or USB flash drive 
during the upgrade!

When the upgrade is complete, your frame automatically restarts. If it doesn’t, press the 
power button on the frame to Off, then back to On.
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Changing your frame orientation
Your frame is set up to display pictures and videos in landscape orientation . You 
can turn the frame on its side to change the orientation to portrait . But, you must 
also change the orientation setting to portrait.

Change the stand position:

■ Turn the frame 90 ° and carefully set it on a stable 
surface.

Change the frame orientation setting:
1 Tap  (Home), then tap  (Settings).

2 Slide to highlight  (Viewing options), then tap 
OK.

3 Slide to highlight Frame orientation, then tap OK.

4 Slide to highlight Portrait, then tap OK.

5 Tap  to exit.

Your frame is set up now to display pictures in portrait 
 orientation.

Landscape

Portrait
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Maintaining your frame
IMPORTANT: Always disconnect the power before cleaning. Do not use water, cleaning 

solutions, or other adhesives on the frame or any of its parts.

Gently wipe the frame and OLED screen with a clean, dry, lint-free cloth (included). 
For fingerprints on the frame, apply light pressure.

Learning more about your frame
www.kodak.com/go/OLEDframe Learn more about your frame and OLED technology

www.kodak.com/go/digitalframesupport Extended user guide
Interactive troubleshooting and repairs
Interactive tutorials
Frequently asked questions
Downloads
Product registration
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8 Troubleshooting and support

For step-by-step product support, visit www.kodak.com/go/digitalframesupport and 
select Step-by-Step Solutions & Repair.

Frequently asked questions
I already have KODAK EASYSHARE Software on my computer. Do I have to 
install it again?

The CD that was packaged with your frame contains a special version of EASYSHARE 
Software that lets your computer share pictures with your frame. Install it to upgrade 
to this special software version. See page 8.

I lost my Internet connection in the middle of my setup. What should I do?

Reconnect to the Internet and repeat the installation and setup, starting on page 5.

I can’t find my network. What should I do?

■ Is your network set up to broadcast SSID? If not, you must enter your wireless 
network information manually (see If your wireless network is not found, page 8). 
The person who set up your network can help you with the necessary information.

■ Does your network have security enabled (WEP or WPA)? If so, see page 6.

I can’t find my network computer. What should I do?

■ Make sure your router and your computer are on.

■ Make sure your computer is on your wireless network. See the documentation that 
came with your router and your computer.

■ Make sure you allowed your frame to share content with your computer (also 
known as enabling media sharing). If you didn’t select ’Enable media sharing’ 
during the initial software installation and setup (see page 9), you can do so now. 
Here’s how:
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Troubleshooting and support
1 Open KODAK EASYSHARE Digital Display Software on your computer.
2 Select Tools → Preferences → General tab.

3 Select Enable wireless media sharing on my home network.

If you are still getting a message on your frame that says, “Please select Allow 
on computer and try again”, see page 68.

I didn’t connect to my network the first time I turned on my frame. Can I 
do it now?

Yes, you can. 

1 Tap Home  → Settings . Slide to highlight Network, then tap Select. 

2 Highlight Scan for wireless networks, then tap OK.

3 Continue with step 1 on page 5.

Picture frame problems
If... Try one or more of the following

Frame cannot connect 
to the wireless network 
—“Wireless network 
not found” appears.

■ Make sure you have a wireless router and that it is broadcasting 
the SSID, or enter the SSID manually.

■ Make sure you are within the operating range of the network. 
Move the frame into the same room with the router.

■ Make sure your frame is using the latest firmware. Check 
www.kodak.com/go/digitalframesupport for updates.

■ If your network security is enabled, see page 6 to enter your 
security key (WEP or WPA). The person who set up your network 
can help you with this information.

Frame does not 
turn on.

■ Make sure the power cable that was included with your frame is 
connected securely (see page 1).

■ Unplug the power cable for 5 seconds, then reconnect the cable. 
Press and hold the power button (for about 2 seconds), then 
release.
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Troubleshooting and support
Nothing happens when 
a memory card, camera, 
or USB device is 
connected.

■ Insert a certified SD/SDHC/MMC/MS/xD Card with images into the 
designated card slot, then push to seat it (see page 26).

■ Make sure the USB cable that was included with your camera or 
USB device is connected securely (see page 26).

■ Make sure the file format of your pictures and videos are 
supported. (See page 70).

NOTE: Do not insert a SANDISK Memory Stick, PRO DUO Card or other micro or mini 
memory card without an adapter.

NOTE: Pictures may take a longer time to display when: the picture/video files are 
large; when using a large capacity memory card or other connected device.

Touch border doesn’t 
work.

■ Use your finger to make your selections on the touch-sensitive 
borders (see page 3). Lights on the border show you where to 
touch.

IMPORTANT: Do not slide on the right border (tap only).
■ Unplug the power cable for 5 seconds, then reconnect the cable. 

Press and hold the power button (for about 2 seconds), then 
release. 

Frame freezes up or 
doesn’t work properly.

■ Unplug the power cable for 5 seconds, then reconnect the cable. 
Press and hold the power button (for about 2 seconds), then 
release.

■ Reset the frame. Press the Volume and Power buttons (see page ii) 
at the same time, then tap Yes to reset the frame. (Resetting your 
frame does not erase your saved files.)

Music doesn’t play. ■ Make sure the volume is turned up (see page ii).
■ If your frame has songs you purchased, they may be protected files. 

Convert the files to standard (unprotected) AAC or MP3 formats.

You set automatic 
on/off but the frame 
doesn’t turn on and off 
at the specified times.

■ Make sure you Enabled the on/off setting after you set the times, 
then press OK (not Back). See page 58.

■ If your frame loses power, the clock returns to the factory setting 
and auto on/off times are disabled. See Resetting the clock after 
losing power, page 66. 

If... Try one or more of the following
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Resetting the clock after losing power
If you turn off the power on the frame or otherwise lose power for half a day or more, 
the clock time returns to the factory setting and the automatic on/off times, if set, are 
disabled.

■ When you turn the frame back on, the set time screen appears on the frame.

■ Slide to set the hour. Tap the left/right arrows to highlight the previous or next 
setting (hour and minutes), then slide to adjust the setting.

■ Tap OK.

The Home screen appears. The time is reset and the automatic on/off times (if set) are 
re-enabled. It is not necessary to reset the on/off times.

NOTE: If you exit the set time screen without setting the time, you can manually reset the clock and 
re-enable the automatic on/off times (see page 58). It is not necessary to reset the on/off times.

Picture frame/computer communications
If... Try one or more of the following

Cannot copy pictures to my 
computer.

■ Make sure your frame and computer are on. 
■ Make sure to install the software that was packaged with 

your frame (see page 8) and copy pictures between your 
frame and computer using the EASYSHARE Digital Display 
Software (page 44).

■ Make sure the USB cable is securely connected (page 26).
■ Make sure the power button on the frame is On (page ii).

Cannot see my frame as a 
removable drive.

Cannot copy pictures from 
KODAK EASYSHARE 
Software.

■ Make sure your frame and computer are on.
■ Make sure the USB cable is securely connected (page 26).
■ Make sure to install the software that was packaged with 

your frame (page 8).
■ From My Collection in EASYSHARE Software, make sure the 

pictures are in the Picture Tray.
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Screen messages

Cannot copy pictures from 
one device to another even 
though the copy destination 
is not full.

Storage devices that have FAT (File Allocation Table) 16 
formatting can only store up to 512 files in its top level (root) 
directory. To make sure all your pictures copy properly, format 
the copy destination to FAT32 before copying to it:
Caution: Formatting deletes all pictures and videos, 
including protected files.

1 Connect the device to your computer.

2 Open My Computer and locate the device.

3 Right-click on it and choose Format.

4 From the File system drop-down menu, choose FAT32 then 
click Start.

Screen message Try one or more of the following

File is bad.
 (usually preceded by the file 
name: xxx_xxxx.JPG file is bad or 
xxx_xxxx.MOV file is bad)

The frame is unable to display the picture or video because 
the file is corrupted or it’s an unsupported file format 
(page 71).
Note that HD videos are not supported. Therefore an MOV 
video, in HD, will not play even though the MOV format is 
supported.

Create file failed. The device (memory card, USB drive, camera, etc.) you are 
trying to copy to is protected.

■ See your device documentation to remove write 
protection.

■ Insert or connect a different device.

Printer unavailable.
Unable to connect to printer.

■ Make sure your printer is on and the USB cable is 
securely connected (page 50).

■ Make sure you changed your USB connection mode 
from computer to printer (page 51).

If... Try one or more of the following
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Printing error. ■ Make sure your printer is on and the USB cable is 
securely connected (page 50).

■ Check your printer for more info.

Time out occurred while printing. ■ Check cables and printer supplies. Print again.

Write failed. Select another 
location.

The frame was unable to copy the picture. 

■ Insert a different card or device (page 26).

Unable to create file. Device write 
protected or full.

The frame was unable to copy the picture. 

■ Insert a different card or device (page 26).
■ Remove write protection, unlock card.
■ Delete pictures from card.

Disk full.

Please select Allow on computer 
and try again

The frame is attempting to access your computer through 
WINDOWS MEDIA Player (instead of KODAK EASYSHARE 
Digital Display Software); and the frame has not been 
’allowed’ in MEDIA Player.
To access your computer using WINDOWS MEDIA Player:

1 Allow the frame in MEDIA Player: Select Library → 
Media Sharing. Follow the on-screen directions to 
allow your frame.

2 Tap Home → Pictures and Videos. Select a computer 
name that starts with the frame name, not Kodak 
(indicates a connection through WINDOWS MEDIA 
Player.). 

To access your computer using EASYSHARE Digital Display 
Software (recommended):

■ Tap Home → Pictures and Videos. Select a computer 
name that starts with Kodak (indicates a connection 
through Digital Display Software). 

Screen message Try one or more of the following
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Error attempting to open file or 
directory.

■ Turn off the frame, then turn it back on. Press and 
hold the power button (for about 2 seconds), then 
release. If the problem persists, contact customer 
support help, at 
www.kodak.com/go/digitalframesupport.

Error duplicate filename.

Error occurred while closing a file.

Error invalid filename.

Error reading from file.

Error writing from file.

Error writing a file.

Error writing to a file.

File Copy Failed!

Internal error.

Parameter is invalid.

Unknown error.

Screen message Try one or more of the following
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9 Appendix

Digital frame specifications
For more specifications, visit www.kodak.com/go/digitalframesupport.

KODAK OLED Wireless Frame, model OL7620

Color display

Type AMOLED active matrix organic light emitting diode

Brightness 200 nits (minimum)

Contrast ratio >30,000:1

Size 19.3 cm (87.6 in.) diagonal digital LCD, 800 x 480 pixels, 16:9 aspect ratio,
17.6 x 10 cm (6.9 x 3.9 in.) viewable area

Internal storage capacity

2 GB

Power

United States
Worldwide

100 - 120 V AC, 60 Hz
100 - 240 V AC, 50-60 Hz
12 V DC

Power 
consumption

On: 10.9 watts, Standby: 0.45 watts, Off: 0.45 watts

Communication with computer

USB 2.0 cable

Wi-Fi wireless network compatibility

802.11 b/g standard protocols
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Other features

PICTBRIDGE 
Support

Yes

Picture formats JPEG, JPG, EXIF 2.2

Video formats MOV, AVI, MPG, MPEG 1, 2, 4, MJPEG

NOTE: HD (High Definition) is not supported on your frame. Video formats created 
with digital cameras are certified for KODAK Digital Frames. Videos created 
with or copied from other sources may not play on your frame.

Music formats MP3, PCM G.711

Memory cards MMC (MULTIMEDIA Card); SD/SDHC (SECURE DIGITAL/SECURE DIGITAL 
High Capacity); MEMORY STICK, xD (xD-Picture Card)

Tripod mount 1/4 inch

Temperature Operating: 32 to 122°F (0 to 50°C)
Storage: -4 to 140°F (-20 to 60°C)

Size 14.9 x 21 x 9.8 cm (5.9 x 8.3 x 3.6 in.)

Weight 644 grams (1.4 lb.)

KODAK OLED Wireless Frame, model OL7620
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Appendix
Important safety instructions

CAUTION:
Do not disassemble this product; there are no user-serviceable 
parts inside. Refer servicing to qualified service personnel. Do not 
expose this product to liquid, moisture, or extreme temperatures. 
The use of controls, adjustments, or procedures other than those 
specified herein may result in exposure to shock and/or electrical 
or mechanical hazards. If the OLED screen breaks, do not touch 
the glass or liquid. Contact Kodak customer support.

CAUTION:
When using this product, it should be installed and operated with 
a minimum distance of 7.9 in. (20 cm) for 2.4 GHz operations 
between the radiator and your body. This transmitter must not be 
collocated or operated in conjunction with any other antenna or 
transmitter.

■ The use of an accessory that is not recommended by Kodak may cause fire, electric 
shock, or injury. For approved accessories, visit www.kodak/go/accessories.

■ Use only a USB-certified computer equipped with a current-limiting motherboard. 
Contact your computer manufacturer if you have questions.

■ When displayed, the frame rests at a 68 - 90 degree angle.
■ Do not place frame near open flame sources such as lighted candles or heaters. 

■ Excessive sound pressure from earphones and headphones may cause hearing 
loss.
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Appendix
Upgrading your software and firmware
Upgrade to the latest versions of the software included on the KODAK EASYSHARE 
Software CD and the frame firmware—www.kodak.com/go/digitalframedownloads. 
See page 59 for upgrading firmware.

Additional care and maintenance
■ To clean the frame or OLED screen, use a soft lint-free cloth (included) dampened 

with lens cleaning solution or a water-based cleaning solution. Use light pressure.

■ Do not allow chemicals, such as suntan lotion, to contact painted surfaces.

■ Service agreements are available in some countries. Contact a dealer of Kodak 
products for more information.

■ For digital frame disposal or recycling information, contact your local authorities. In 
the US, visit the Electronics Industry Alliance Web site at www.eiae.org or visit 
www.kodak.com/go/digitalframesupport.

Limited warranty
Kodak warrants Kodak consumer electronic products and accessories (“Products”), 
excluding batteries, to be free from malfunctions and defects in both materials and 
workmanship for one year from the date of purchase. Retain the original dated sales 
receipt. Proof of the date of purchase will be required with any request for warranty 
repair.

Limited warranty coverage
Warranty service is only available from within the country where the Products were 
originally purchased. You may be required to ship Products, at your expense, to the 
authorized service facility for the country where the Products were purchased. Kodak 
will repair or replace Products if they fail to function properly during the warranty 
period, subject to any conditions and/or limitations stated herein. Warranty service 
will include all labor as well as any necessary adjustments and/or replacement parts. If 
Kodak is unable to repair or replace a Product, Kodak will, at its option, refund the 
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Appendix
purchase price paid for the Product provided the Product has been returned to Kodak 
along with proof of the purchase price paid. Repair, replacement, or refund of the 
purchase price are the sole remedies under the warranty. If replacement parts are 
used in making repairs, those parts may be remanufactured, or may contain 
remanufactured materials. If it is necessary to replace the entire Product, it may be 
replaced with a remanufactured Product. Remanufactured Products, parts and 
materials are warranted for the remaining warranty term of the original Product, or 90 
days after the date of repair or replacement, whichever is longer.

Limitations
This warranty does not cover circumstances beyond Kodak's control. This warranty 
does not apply when failure is due to shipping damage, accident, alteration, 
modification, unauthorized service, misuse, abuse, use with incompatible accessories 
or attachments (such as third party ink or ink tanks), failure to follow Kodak's 
operation, maintenance or repacking instructions, failure to use items supplied by 
Kodak (such as adapters and cables), or claims made after the duration of this 
warranty. Kodak makes no other express or implied warranty for this product, and 
disclaims the implied warranties of merchantability and fitness for a particular 
purpose. In the event that the exclusion of any implied warranty is ineffective under 
the law, the duration of the implied warranty will be one year from the purchase date 
or such longer period as required by law. The option of repair, replacement, or refund 
is Kodak's only obligation. Kodak will not be responsible for any special, 
consequential or incidental damages resulting from the sale, purchase, or use of this 
product regardless of the cause. Liability for any special, consequential or incidental 
damages (including but not limited to loss of revenue or profit, downtime costs, loss 
of the use of the equipment, cost of substitute equipment, facilities or services, or 
claims of your customers for such damages resulting from the purchase, use, or failure 
of the Product), regardless of cause or for breach of any written or implied warranty is 
expressly disclaimed.
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Your rights
Some states or jurisdictions do not allow exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 
Some states or jurisdictions do not allow limitations on how long an implied warranty 
lasts, so the above limitation may not apply to you. This warranty gives you specific 
rights, and you may have other rights which vary from state to state or by jurisdiction.

Outside the United States and Canada
In countries other than the United States and Canada, the terms and conditions of 
this warranty may be different. Unless a specific Kodak warranty is communicated to 
the purchaser in writing by a Kodak company, no warranty or liability exists beyond 
any minimum requirements imposed by law, even though defect, damage, or loss may 
be by negligence or other act.

FCC compliance and advisory

This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed or used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following measures: 1) reorient 
or relocate the receiving antenna; 2) increase the separation between the equipment 
and the receiver; 3) connect the equipment to an outlet on a circuit different from that 

KODAK OLED Wireless Frame, model OL7620
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to which the receiver is connected; 4) consult the dealer or an experienced radio/TV 
technician for additional suggestions.

Any changes or modifications not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment. Where shielded 
interface cables have been provided with the product or specified additional 
components or accessories elsewhere defined to be used with the installation of the 
product, they must be used in order to ensure compliance with FCC regulation.

FCC and Industry Canada
This device complies with Industry Canada RSS-210 and FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

Hereby, Eastman Kodak Company declares that this KODAK Product is in compliance 
with the essential requirements and other relevant provisions of Directive 1999/5/EC.
This digital picture frame transmits in 10 dBm. In France, the power level is limited to 
10 dBm in outdoor environments, per regulations. When in France, use the wireless 
functions of this device indoors only.
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Canadian DOC statement
DOC Class B Compliance—This Class B digital apparatus complies with Canadian 
ICES-003.

Observation des normes-Classe B—Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada.

Waste Electrical and Electronic Equipment labeling

MPEG-4
Use of this product in any manner that complies with the MPEG-4 visual standard is 
prohibited, except for use by a consumer engaging in personal and non-commercial 
activities.

Licensing
Supply of this product does not convey a license nor imply any right to distribute 
content created with this product in revenue-generating broadcast systems 
(terrestrial, satellite, cable and/or other distribution channels), streaming applications 
(via Internet, intranets and/or other networks), other content distribution systems 
(pay-audio or audio-on-demand applications and the like) or on physical media 
(compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards 
and the like). An independent license for such use is required. For details, please visit 
http://mp3licensing.com.

EU: It is the final user’s responsibility to discard this equipment into an 
approved, segregated collection scheme to enable its suitable 
treatment/disposal and to improve human/environmental protection. For 
more information, see your retailer, local authority, or 
www.kodak.com/go/recycle.
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Index 1

A
about, frame, 58
allow, media sharing, 63, 68
appendix, 70
audio in/out, ii
audio options, 48, 56
automatic on/off, 57, 58

B
border, touch, 3

C
cable

power, connecting, 1
cables

USB, connecting, 26
camera, connecting, 26
card, memory

inserting, 26
slot, i

cards, memory
supported formats, 71

changing picture locations, 27, 28
cleaning frame, 62, 73
clock and timer, setting, 57, 58, 66
computer

copying to/from, 44
help with communicating, 66
viewing pictures from, 37

connecting
wireless network, 5, 7

connection mode, 51

connectors, ii
copying

from EASYSHARE Software, 46
to frame’s internal memory, 52
to/from computer, wirelessly, 44

D
date

sort pictures by, 35
deleting

pictures and videos, 53
rss feeds, 24
sample pictures, 25

device settings Web page, 11, 13
displaying slide show, 31
disposal, recycling, 73

E
EASYSHARE Digital Display Software

copying to/from computer, 44
create slide show, 33
installing, 8
setting up Web content, 11

EASYSHARE Software
copying pictures from, 46
installing, 8

emailing pictures from frame, 42
error messages, 67

F
FAQs, 63
fast forward video, 49
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feeds. See rss feeds
file formats, supported, 71
filename, sort by, 35
firmware

checking version, 58
upgrading, 55, 59, 73

flash drive, connecting, 26
FLICKR account

add a feed, 17
set up, 15

frame, picture
checking model, firmware, serial 

number, 58
disposal, 73
resetting, 65
setup, 1
specifications, 70
troubleshooting, 64
turn on/off, 2

FRAMECHANNEL account
add a feed, 19
set up, 16

H
help

communicating with computer, 66
frame, 64
support URLs, 62
troubleshooting and support, 63

home
changing picture locations, 27
screen, shortcuts, 23
viewing picture sources, 28

home screen, 27

I
installing

memory cards, 26
software, 8

internal memory
capacity, 70

IP address, finding, 12

K
KODAK Gallery

receiving from friends and family, 40
set up account, 14
viewing from, 38, 39

KODAK logo, turn off, 56
KODAK PERFECT TOUCH, 56

L
landscape, set orientation, 55, 56, 61
language, setting, 4
logo, turn off, 56

M
MAC OS, set up Web content, 12
magnify picture, 30
media sharing, allow, 63, 68
memory card. See card, memory
multimedia slide show, 33
music

accessing from home screen, 27
playing, 48
supported file formats, 71

My Friends Albums, 40

N
network not found, 8
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O
OLED

learn more, 62
screen specifications, 70
screen, cleaning, 62, 73

on/off, setting auto, 57, 58
options, slide show, 32
orientation setting, 55, 56, 61

P
PictBridge enabled printer, 50
pictures

copying from EASYSHARE 
Software, 46

copying to computer, 44
copying to internal memory, 52
deleting, 53
emailing from frame, 42
location, changing, 27
location, viewing, 28
samples, deleting, 25
selecting more than one, 54
shuffle play, 55
sort by date or filename, 35
supported file formats, 71
thumbnails, 29
viewing locally, 25
viewing single, 30
viewing wirelessly, 36
zoom, 30

playing
music, 48
slide show, 31
videos, 49

portrait, set orientation, 55, 56, 61
power

button, ii, 2
connecting, 1
specifications, 70

printer connection mode, 51
printing, PictBridge printer, 50

Q
quick touch border, 3

R
recycling, disposal, 73
regulatory compliance, 75
reset frame, 65
rewind video, 49
rotate picture, 30
rss feeds

adding, 17, 21
editing, deleting, 24
shortcuts to, 23
viewing, 38, 39

S
safety information, 72
screen

cleaning, 73
error messages, 67
OLED, learn more, 62
OLED, specifications, 70

security key, 6
selecting

menus and pictures, 3
multiple pictures, 54

serial number, checking, 58
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setting
audio options, 48
auto on/off, 57, 58
clock after losing power, 66
clock and timer, 58
FLICKR account, 15
FRAMECHANNEL account, 16
Gallery account, 14
language, 4
slide show options, 32
time, 57
viewing options, 55, 56
wireless network, 5

setup
picture frame, 1
Web content, 11

share (email) pictures, 42
shuffle

music play, 48
picture/slide show play, 55

slide duration, setting, 55, 56
slide show

create with pictures and music, 33
options, 32
playing, 25, 31
sort order, 35

slide transitions, setting, 55, 56
software

installing, 8
upgrading, 73

sort, 35
source, picture location, 27, 28
specifications, frame, 70
storage capacity, internal memory, 70

T
thumb drive. See flash drive.
thumbnails, 29
time, setting, 57
transitions, slides, setting, 55, 56
troubleshooting

error messages, 67
frame, 64

turn on frame, 2

U
upgrading

firmware, 55
software and firmware, 73

USB
connection mode, 51
connectors, ii
device, connecting, 26

V
videos

HD, not supported, 49
playing, 49
supported file formats, 71

viewing
picture sources, 28
pictures, locally, 25
pictures, wirelessly, 36
rss feeds, 38, 39
single picture, 30
thumbnails, 29

volume control, ii
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W
warranty, 73
Web content

setting up, 11
viewing, 38

Web feeds
adding, 17
creating shortcuts, 23
editing, 24
viewing, 38, 39

WINDOWS OS
installing software, 8
open device settings Web page, 11

wireless network
connecting, 5, 7
copying to/from computer, 44
not found, 8
security, 6
troubleshooting, 63, 64
viewing pictures, 36

Z
zoom picture, 30
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